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MatriX: FREM

La figura consente di gestire dei commenti o delle note attraverso una o più figure da disporre entro il job.
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MatriX: FCNT

In linea di massima le figure di tipo contatore vengono usate per 'conteggiare' delle marcature o per fermare la

produzione quando si raggiunge un valore prestabilito: quando il valore del campo Value raggiunge infatti quello di

Stop, l'esecuzione del layer ha termine.

Le figure contatore hanno senso solo in un contesto di start-job o start-layer in quanto modificano la normale

sequenza di esecuzione di un layer.

I valori assegnati ai campi Start e Stop determinano se il contatore e' a incremento o decremento, mentre il campo

Step determina l'entità dell'incremento o del decremento per ogni esecuzione/iterazione.

Il flag Enabled consente di abilitare o disabilitare il contatore a piacere, in modo da poter effettuare delle

marcature non conteggiate o da produrre al più pezzi di quelli previsti nel contatore stesso

Il campo Value riporta il valore corrente del conteggio e puo' essere modificato per correggere eventuali errori o

scarti.

La voce del menu principale Options->Enable counters consente di abilitare o disabilitare globalmente i contatori,

agendo su tutti i contatori presenti in quel momento nell'area di lavoro (ovvero su tutti i layer).

La voce del menu principale Actions->Reset counters consente di resettare globalmente i contatori, agendo su tutti

i contatori presenti in quel momento nell'area di lavoro (ovvero su tutti i layer): il reset di un contatore consiste nel

portare il sul Value al valore impostato in Start

Quando il campo Value raggiunge il valore di Stop il conteggio si ferma e l'esecuzione del layer corrente (o

dell'intero job, se ho uno start-job) ha termine.

Avvertenze

quando un contatore e' disabilitato, la sua variabile esiste comunque e restituisce Value

le variabili contatore counter1, counter2 etc etc NON vengono inizializzate all'inizio del job, e non e' quindi

consigliato farvi riferimento se non dopo un contatore stesso e all'interno dello stesso layer: evitare quindi di

fare dei jump condizionati da un contatore prima del contatore stesso o su un layer diverso da quello in cui si

trova il contatore stesso (a meno che si usi sempre lo start-job)
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MatriX: Expression

Le figure espressione consentono di creare delle variabili inizializzate o di valutare delle espressioni.

Le variabili sono sempre di tipo double

Le espressioni possono contenere numeri o altre variabili, oltre che nomi di funzione.

Le funzioni di base sono:

Function Parms Description

sin 1 sine function

cos 1 cosine function

tan 1 tangens function

asin 1 arcus sine function

acos 1 arcus cosine function

atan 1 arcus tangens function

sinh 1 hyperbolic sine function

cosh 1 hyperbolic cosine

tanh 1
hyperbolic tangens

function

asinh 1
hyperbolic arcus sine

function

acosh 1
hyperbolic arcus tangens

function

atanh 1
hyperbolic arcur tangens

function

log2 1 logarithm to the base 2

log10 1 logarithm to the base 10

log 1 logarithm to the base 10

ln 1
logarithm to base e

(2.71828...)

exp 1 e raised to the power of x

sqrt 1 square root of a value

sign 1
sign function -1 if x<0; 1

if x>0

rint 1 round to nearest integer

abs 1 absolute value

if 3 if ... then ... else ...

min var. min of all arguments

max var. max of all arguments

sum var. sum of all arguments
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avg var.
mean value of all

arguments

Le funzioni definite da matriX sono invece:

table(numero_tabella, indice_cella) per accedere al contenuto di una cella di una tabella tramite un indice

tablexy(numero_tabella, colonna, riga) per accedere al contenuto di una cella di una tabella tramite due indici (riga e colonna)

tablerows(numero_tabella) per avere il numero totale di righe di una tabella

tablecols(numero_tabella) per avere il numero totale di colonne di una tabella

tablecount(numero_tabella) per avere il numero totale di celle di una tabella
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MatriX: Dynamic focus fig

La figura fuoco dinamico consente di variare il fuoco dinamico durante l'esecuzione di un job.

Poiche', nella configurazione standard di matriX, ogni figura raster o vettoriale "ingloba" un proprio valore di

fuoco, occorre disabilitare la voce "Figures own focus" nelle opzioni, in modo che tali figure lascino il fuoco

dinamico dove si trova.

L'unità di misura e' in step di DAC, ovvero da 0 a 255
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MatriX: Label

Le figure di tipo label introducono semplicemente dei "punti di ingresso" preferenziali per i salti: vengono inserite

automaticamente dalle macro che risultano cosi' più generalizzate in quanto i salti avvengono su elementi della

macro invece che su quelli della selezione (che puo' quindi essere modificata).
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MatriX: System Pen fig

La figura "penna di sistema vettoriale" consente di modificare o legare a delle variabili i parametri principali di una

penna di sistema vettoriale.

Tra le proprietà che possono essere cambiate vi sono potenza, frequenza, velocità, superpulse e flag di abilitazione.

Le modifiche sono apportate solo in fase di esecuzione del job e influiscono (ovviamente) sulle sole figure vettoriali

che utilizzano le penne di sistema.
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MatriX: Jump

Le figure di tipo jump consentono di effettuare dei salti (condizionati o meno) all'interno di un job.

Se la condizione e' verificata, la normale sequenza del job viene modificata e si salta alla figura indicata nella

clausola then, altrimenti si salta alla figura specificata nella clausola else

Se non viene specificata nessuna condizione, viene valutata la label specificata nella clausola then

Se la condizione e' specificata ma manca la clausola then o else verificata dalla valutazione dell'espressione, il

flusso prosegue sequenzialmente.
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MatriX: Figure FTAB: figure di tipo ''tabella''

Le figure di tipo tabella consentono di definire e 'popolare' delle generiche tabelle di n righe e m colonne, con n e m stabilite

dall'utente.

Una volta definita una tabella, è possibile editarne il contenuto cella per cella (modalità cell-mode) o per insieme di celle

(modalità range-mode): in questo caso, dopo aver selezionato le celle, è possibile richiamare una delle funzioni di popolamento

previste tramite il menù contestuale (pop-up).

In ogni caso e' consentito ridimensionare la tabella, anche se già 'popolata', con l'unica limitazione che la riduzione del numero

di colonne o di righe comporta la perdita dei dati contenuti nelle righe e/o nelle colonne rimosse.

Le tabelle devono avere come nome la parola chiave table seguita da un numero progressivo.

Per accedere ad una cella sono a disposizione due funzioni:

entrambe restituiscono un double

La funzione:

al contrario restituisce una stringa

Altre tre funzioni consentono di accedere rispettivamente al numero di righe, al numero di colonne e al numero totale di

elementi di una tabella:
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tutte e tre restituiscono un int

L'uso delle tabelle è facilitato dalla presenza delle macro New table rows cycle, New table cols cycle e New table count cycle,

che consentono di creare dei cicli basati rispettivamente sul numero di righe, sul numero di colonne e sul numero totale di celle

di una tabella.

NB: le macro in questione servono solo come guida rapida per creare dei cicli basati su tabelle e non implementano, di per se,

alcuna funzione 'finita'... per completare una macro di questo tipo occorre infatti definire il valore delle celle nella tabella e farvi

puntare una o più proprietà di un oggetto (raster, vettoriale, penna di sistema, ritardo etc) tramite le funzioni table() o tablexy().
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From DS4 Wiki Project

MatriX: Timer

Le figure di tipo timer consentono di introdurre dei ritardi tra le operazioni di un job

Il ritardo e' espresso in millisecondi o, eventualmente, risolto da un'espressione
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MatriX: Square macro

La macro Square consente di creare "al volo" un quadrato, con o senza

riempimento.

La macro NON può essere 'riaperta' ne modificata in automatico una volta

creata in quanto NON HA un oggetto FMAC associato

Il numero di ripetizioni si riferisce al solo contorno esterno e viene tracciato

dopo l'eventuale riempimento in modo da rifinire lo scavo; se anche lo

scavo deve essere effettuato in piu' passate, l'oggetto deve essere racchiuso

in una macro ripetizione.

L'oggetto square puo' essere usato come base di una macro Engrave Test

per valutare l'effetto della stessa marcatura effettuata a potenze e frequenze diverse.
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MatriX: Repeat macro

La macro ripetizione consente di ripetere una determinata operazione due o più volte: le operazioni ripetute, in particolare,

sono quelle selezionate prima dell'attivazione della macro.

le macro ripetizioni

producono un risultato finito (non c'e' bisogno di aggiungere altro)

possono essere annidate

possono racchiudere qualsiasi tipo di oggetto

possono essere 'riaperte' e modificate in automatico tramite le proprietà dell'oggetto macro (FMAC) associato

non modificano/aggiornano in alcun modo le espressioni delle figure selezionate

NB: salti condizionali o contatori possono modificare il comportamento della macro ripetizione.

NB: la cancellazione di una macro può essere effettuata manualmente, eliminando le figure che compongono la macro e le

eventuali espressioni che la macro stessa ha inserito nelle figure target o, più facilmente, cancellando la sola figura FMAC

ovvero la sola figura macro.

NB: la cancellazione, la modifica o lo spostamento di layer di un elemento qualsiasi della macro può invalidare la macro o

l'intero job...

1 di 1



MatriX: SHS Cycle Macro

Le macro cycle SHS consentono di creare cicli caratterizzati da n elementi,

posti a partire da un punto di start fino ad un punto di stop con passo step

e/o numero di elementi items

viene implementata attraverso un ciclo basato sulle righe di una tabella

Le macro di tipo SHS cycle

possono essere annidate senza problemi poiche' ogni ciclo introduce un oggetto asse SHS separato e

autonomo

è possibile annidare cicli galvanometrici con cicli di assi

è possibile annidare cicli di assi con ripetizioni e viceversa

possono essere riaperte e modificate tramite le proprietà dell'oggetto macro (FMAC) associato

NON modificano le espressioni delle figure selezionate

NB: la cancellazione di una macro può essere effettuata manualmente, eliminando le figure che compongono la

macro e le eventuali espressioni che la macro stessa ha inserito nelle figure target o, più facilmente, cancellando la

sola figura FMAC ovvero la sola figura macro.

NB: la cancellazione, la modifica o lo spostamento di layer di un elemento qualsiasi della macro può invalidare la

macro o l'intero job...
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MatriX: Cycle Macro

Le macro cycle consentono di creare cicli caratterizzati da n elementi, posti

a partire da un punto di start fino ad un punto di stop con passo step e/o

numero di elementi items

viene implementata attraverso un ciclo basato sulle righe di una tabella

Le macro di tipo cycle

possono essere annidate, ma occorre fare attenzione al target, che non deve sovrapporsi: è cioè possibile

avere un ciclo galvanometrico che lavora sulle X e uno che lavora sulle Y, ma non due cicli che lavorano

sulla contemporaneamente sulla X o sulla Y in quanto quello piu' esterno andrebbe a modificare l'espressioni

di quello interno. In caso di conflitti viene comunque visualizzato un messaggio di errore.

è possibile annidare cicli galvanometrici con cicli di assi

è possibile annidare cicli di assi con ripetizioni e viceversa

possono essere riaperte e modificate tramite le proprietà dell'oggetto macro (FMAC) associato

modificano e gestiscono le espressioni delle figure selezionate: ciò significa che se la macro viene rimossa,

vengono rimosse anche le relative espressioni

NB: la cancellazione di una macro può essere effettuata manualmente, eliminando le figure che compongono la

macro e le eventuali espressioni che la macro stessa ha inserito nelle figure target o, più facilmente, cancellando la

sola figura FMAC ovvero la sola figura macro.

NB: la cancellazione, la modifica o lo spostamento di layer di un elemento qualsiasi della macro può invalidare la

macro o l'intero job...
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MatriX: Table cycle

La macro consente di creare cicli generici, basati sulle righe, sulle colonne o sugli elementi di una qualsiasi tabella

la macro non produce un risultato finito in quanto sta all'utente definire come popolare la tabella e che

caratteristica/proprietà attribuire ogni singola riga/colonna/cella.

la macro può essere 'riaperta' ma non modificata in automatico tramite le proprietà dell'oggetto macro

(FMAC) associato

la macro NON modifica, di per se, le espressioni delle figure selezionate... la modifica di tali espressioni e'

infatti a carico dell'utente...

NB: la cancellazione di una macro può essere effettuata manualmente, eliminando le figure che compongono la

macro e le eventuali espressioni che la macro stessa ha inserito nelle figure target o, più facilmente, cancellando la

sola figura FMAC ovvero la sola figura macro.

NB: la cancellazione, la modifica o lo spostamento di layer di un elemento qualsiasi della macro può invalidare la

macro o l'intero job...
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MatriX: Macro di scavo raster

Le macro di scavo raster consentono di effettuare degli scavi basandosi sui valori di grigio di una immagine raster

Per attivare la macro, portarsi su un layer valido (da 1 a 31), caricare l'immagine da processare, selezionarla e quindi

attivare la macro stessa attraverso il menu Insert->New macro->Macro di scavo raster : verranno automaticamente creati

tutti gli oggetti (variabili, salti, tabelle etc) necessari per gestire lo scavo.

Al momento e' possibile definire il numero di "passate" (4, 8, 16, 32, 64, 128 o 256) la tipologia (immagine scavata o in

risalto) e il valore di potenza da associare alle penne.

Agendo sulla tabella contenuta nella macro, e' possibile associare ad ogni passata

un valore variabile di ripetizioni (colonna 0 della tabella)

una diversa posizione del fuoco dinamico (colonna 1 della tabella)

una quota da inviare ad un asse SHS (tipicamente lo Z) (colonna 2 della tabella)

un offset da inviare all'asse Z del robot Kawasaki (colonna 3 della tabella, se previsto)

L'uso del robot Kawasaki e' previsto solo dalle versioni matriX v1.1.149 in poi

Per cancellare la macro, e' sufficiente cancellare l'oggetto macro corrispondente

NB: il risultato dello scavo è fortemente influenzato dall'immagine scelta (distribuzione dei grigi, immagine

normale/negativa etc)

NB: nel caso in cui si decida di lavorare con immagini negative, si consiglia di ricavare il negativo stesso attraverso un
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programma di elaborazione delle immagini invece che di attivare la corrispondente funzione in matriX

NB: poiche' la macro lavora sulla maschera globale delle penne, questa deve essere attiva Opzioni->Generali->Abilita

Maschera globale penne
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MatriX: LightGrid

Le macro Light grid consentono di creare matrici leggere di elementi; leggere in quanto le posizioni dei singoli

elementi della griglia sono valutare in fase di esecuzione del job e gli elementi non vengono duplicati

La macro viene implementata attraverso un ciclo basato sulle righe di una tabella

Poiche' le varie coordinate sono inserite all'interno della tabella, le posizioni possono essere aggiustate per

compensare eventuali distorsioni ottiche o errori della dima: in questo caso pero' la modifica di una macro non ne

terrà conto.

non è possibile avere due griglie leggere annidate, in quanto agirebbero sulle stesse variabili/espressioni

è possibile creare una griglia leggera di piu elementi selezionati (vengono considerati gli offset relativi)

la macro può essere 'riaperta' e modificata in automatico tramite le proprietà dell'oggetto macro FMAC

associato

la macro modifica le espressioni delle figure selezionate

NB: la cancellazione di una macro può essere effettuata manualmente, eliminando le figure che compongono la

macro e le eventuali espressioni che la macro stessa ha inserito nelle figure target o, più facilmente, cancellando la

sola figura FMAC ovvero la sola figura macro.

NB: la cancellazione, la modifica o lo spostamento di layer di un elemento qualsiasi della macro può invalidare la

macro o l'intero job...
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MatriX: Heavy grid

Le macro Heavy grid consentono di creare matrici di elementi: poiche' gli elementi sono fisicamente duplicati, ogni singola

caratteristica degli stessi e' modificabile (dimensioni, posizioni, rotazione, penne etc etc).

L'occupazione della memoria e' proporzionale al numero di righe per il numero di colonne.

non è possibile avere due griglie pesanti annidate, in quanto agirebbero sulle stesse variabili/espressioni

è possibile avere una griglia pesante di piu elementi selezionati (vengono considerati gli offset relativi)

non e' possibile creare gliglie pesanti di una selezione che contenga dei salti in quanto dovrebbero essere relativizzati

la macro può essere 'riaperta' ma NON modificata in automatico tramite le proprietà dell'oggetto macro (FMAC)

associato

la macro non modifica le espressioni delle figure selezionate

Il risultato di una macro 3x3 e' del tipo:
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Le singole figure raster o vettoriali possono o meno utilizzare le penne di sistema.

NB: la cancellazione di una macro può essere effettuata manualmente, eliminando le figure che compongono la macro e le

eventuali espressioni che la macro stessa ha inserito nelle figure target o, più facilmente, cancellando la sola figura FMAC

ovvero la sola figura macro.

NB: la cancellazione, la modifica o lo spostamento di layer di un elemento qualsiasi della macro può invalidare la macro o

l'intero job...
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MatriX: Fonts

Obiettivi

L'obiettivo principale e' quello di consentire, in matriX, il caricamento di font TrueType (e quindi la selezione di facce,

dimensioni, o stili presenti nel font stesso) al fine di comporre e creare rapidamente delle scritte da marcare o laserare.

Configurazione

Prima di poter lavorare con qualsiasi testo e' necessario indicare a matriX dove ricercare i font stessi: dal menu Settings

occorre attivare la modalità avanzata e quindi il menu Define fonts in modo da aprire il seguente form

Il form e' sostanzialmente diviso in due sezioni: la prima riporta i font attivi o pre-caricati, la seconda quelli disponibili su

disco nei path correntemente configurati.

La configurazione dei path avviene tramite la voce di menu Fonts->Define Paths che apre il seguente form:
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I percorsi hanno tutti radice comune /matriX/fonts

Una volta definiti i percorsi, tutti i font trovati negli stessi verranno elencati tra i font disponibili e l'utente avrà quindi la

possibilità di vederne un preview e/o di selezionare quali precaricare: il pre-caricamento di un font consente di velocizzarne

l'accesso durante le lavorazioni evitando operazioni di I/O su disco ed e', in matriX, un prerequisito per poterlo utilizzare.

Per evitare un eccessivo spreco di memoria e' bene precaricare solo i font che effettivamente intende utilizzare.

L'elenco dei font precaricati viene salvato in un file 'ini e caricato all'avvio di matriX. Ogni elemento della lista contiene il

nome del file, il percorso, il numero di glifi, la famiglia di appartenenza, lo stile etc etc... in aggiunta, viene salvato anche un

checksum MD5 del file in modo da poter identificare in modo univoco font con nomi identici o font corrotti.

Creazione di testi fissi/variabili

Per creare una scritta occorre innanzitutto aggiungere all'area di lavoro un oggetto di tipo text selezionando la voce di menu

Insert->New text: accedendo alle proprietà dell'oggetto sarà quindi possibile selezionare il tipo di font, l'orientamento, il

numero di pixel o di vettori da utilizzare per definirlo, le dimensioni finali della scritta etc etc.

Per i testi variabili occorre spuntare la relativa checkbox e inserire, entro il testo, il nome di una variabile o di una funzione

tra coppie di %; nel testo "Fatti %%r1%% pezzi" r1 e' considerata quindi una variabile e il suo valore viene sostituito nel

testo.

Per accedere al valore numerico di una tabella, valgono le funzioni gia viste in precedenza: %%tablexy(1, 0, r1)%%

ricaverà il valore dalla tabella 1, colonna 0, riga r1.

Per accedere al valore alfanumerico (stringa) di una tabella, e' stata inserita la nuova funzione %%tablestrxy()%% con la

medesima sintassi.

I testi variabili di tipo raster sono da utilizzare con molta cautela in quanto la loro generazione richiede parecchio tempo e

rallentano, di fatto, l'esecuzione del job.
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Una volta creata una scritta, questa può essere modificata attraverso l'oggetto text associato oppure ridimensionata/ruotata

tramite le ancore di selezione: in questo secondo caso si avrà pero' una variazione della definizione (o densità) del testo

stesso.

Ingrandire una scritta attraverso le ancore non comporta cioe' un nuovo rendering del testo, e la cosa, evidente nei font

raster, si ripercuote anche sui testi vettoriali in quanto le curve di Bezier non vengono ricalcolate e sopratutto non vengono

ri-discretizzate.

Le scritte ottenute possono essere di tipo raster o vettoriale e quindi marcate con modalità diverse.

Il riempimento vettoriale (l'attuale font riempito del DOS) deve essere ottenuto modificando i font originali (aggiungendovi

ulteriori outline) al di fuori di matriX, attraverso programmi specifici per il trattamento di font truetype (vedi le note

relative ai font unifilari/bifilari/trifilari).

Il font simplex non e' supportato (vedi le note relative ai font unifilari/bifilari/trifilari).

Alcune trasformazioni (flip, cambio di densità etc) comportano la generazione di nuove figure: se si applica una di queste

operazioni ad una scritta si genera una nuova scritta che non e' piu' legata all'oggetto di testo iniziale.

Note relative ai font truetype unifilari/bifilari/trifilari

I font truetype sono stati ideati per descrivere in modo vettoriale i diversi glifi che sono poi rasterizzati da un motore di

rendering, il quale opera andando a riempire i percorsi chiusi descritti vettorialmente attraverso polilinee o curve

quadratiche e cubiche: per questo motivo i classici font simplex, duplex o triplex usati in marcatura non hanno senso per il

rendering, non descrivendo se non accidentalmente dei percorsi chiusi.

Dalla versione di matriX 1.1.131b sono stati inseriti dei font true type 'pensati' per la marcatura e che non possono quindi

essere utilizzati per altri fini: si trovano nella directory del disco di sistema matriX/fonts/laserfontsttf e, per i motivi

descritti sopra, possono essere marcati esclusivamente in vettoriale.

I font in questione possono essere usati solo in marcatura (non funzionano in software di word-processing, in stampa etc) e

il loro preview e' sempre inaccurato (se non del tutto assente).

La marcatura in vettoriale da comunque buoni risultati.

I font in questione potrebbero essere sotto licenza

3 di 4



Note sull'orientamento verticale

La possibilità di rappresentare in verticale un font deve essere prevista nel font stesso, nel senso che chi lo realizza deve

fornire tutte le misure e le distanze necessarie per poterlo rappresentare correttamente a video: poichè nessuno tra i font

trovati (oltre 1500) sembra prevedere tale modalità, in matriX questa non è sostanzialmente stata implementata... la

modalità verticale di matriX (disponibile per tutti i font, verticali o meno che siano) si basa infatti su approssimazioni e

assunzioni che possono, a seconda del font, essere valide o meno e che comunque riducono il livello qualitativo del

risultato finale.

Note tecniche relative all'implementazione in matriX

Per legare una scritta all'oggetto FTXT che lo ha generato viene utilizzato il campo macro, campo inizialmente previsto per

legare le figure generate da una macro alla macro stessa. La cancellazione di un oggetto FTXT non comporta pero' la

cancellazione degli oggetti che questo ha generato (e viceversa).
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MatriX: Hershey fonts

I font di tipo Hershey sono font vettoriali parzialmente riscalabili (il numero di vettori è definito da chi disegna il

font) e con una metrica molto semplificata (sono definite solo le spaziature a sinistra e a destra del glifo).

I font in questione non possono essere marcati in raster e sono stati introdotti principalmente per rimpiazzare i

vecchi font unifilari o "riempiti" di EasyMark (che non potevano essere facilmente implementati in truetype)

matriX supporta tali font dalla v1.1.104 attraverso un form di configurazione e un oggetto di testo personalizzati

(indipendenti dai normali controlli per i font TrueType)

Nel form di configurazione è possibile caricare e visualizzare i glifi e/o assegnare a ciascuno di questi un codice

ASCII: la numerazione originale dei glifi nei font Hershey non rispecchia infatti alcuna codifica standard, sia essa

ASCII o UNICODE.

Per attivare un font Hershey occorre copiarne il relativo file (con estensione .jhf) nella directory /matriX/fonts

/Hershey/ e definire la mappatura ASCII di tutti i suoi glifi: solo dopo questa operazione il font verrà reso

disponibile nell'oggetto di testo Hershey. Essendo i font Hershey disponibili in numero limitato (ne sono stati trovati

circa 15) non è stata prevista la possibilità di definire quali caricare e quali no: tutti i file trovati in /matriX/fonts

/Hershey/ che abbiano almeno un carattere mappato in ASCII vengono quindi caricati in memoria.
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Come per l'oggetto di testo truetype, nell'oggetto di testo Hershey e' possibile selezionare il font voluto, definire il

testo (con eventualmente delle parti variabili), le sue dimensioni, l'interlinea etc etc. La possibilità di marcare in

verticale è stata abbozzata a partire dalla release di matriX v1.1.105

NB: i font in questione non sono ottimizzati per la marcatura ed è quindi possibile che si abbiano punti di foratura o

tratti marcati due volte: in internet sono comunque disponibili dei programmi per modificare o creare tali font o,

eventualmente, occorrerà scrivere una applicazione apposita.
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MatriX: Maschera globale delle penne

La maschera globale delle penne consente di disabilitare a livello di applicazione una o piu' penne lavorando

"bit-a-bit": si tratta cioè di una maschera di 256 bit nella quale ad ogni bit e' associato una penna

Per motivi di implementazione, la maschera è stata suddivisa in 8 sottomaschere, contenenti ciascuna 32 penne

Sebbene la maschera globale delle penne sia stata introdotta principalmente per le raster, questa lavora anche sulle

figure di tipo vettoriale.

Il valore di default della maschera è (2^32)-1 ovvero 4294967295 (ovvero, in binario,

11111111111111111111111111111111)

La maschera globale delle penne è alla base delle macro di scavo raster

L'abilitazione/disabilitazione avviene a livello di sistema nel menu Opzioni->Generali
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